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1 Summary 

This report describes the procedures required for the conversion of bit-maps of paper seismic 

sections into industry standard SEG-Y files. It uses Seistrans, a product of Caldera Graphics and 

ProMAX, a Halliburton product. It is a companion report to IR/10/078 which describes the 

scanning of paper seismic sections into B/W TIFF files suitable for vectorisation using Seistrans. 
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2 Introduction 

 

Many academic, governmental and commercial organisations have acquired considerable 

volumes of paper seismic records over many decades. The ubiquitous use of seismic 

interpretation workstations and the realisation that such legacy data still have value in frontier 

areas has led to the emergence of specialist companies involved in ‘vectorisation’ of paper 

records, i.e. converting a two dimensional bit-map of a paper record into a standard file of traces 

and time-series values i.e. a SEG-Y format file. The SEG-Y format (see Barry et al. 1975 for 

definition) is the most common file structure used for seismic data exchange.  

Vectorisation services are often expensive for academic institutions, so in 2001, an EC funded 

project called SEISCAN (EC FP5 project EVR1-CT-2001-40016) was commissioned to develop 

a cheaper alternative under the leadership of the National Oceanographic Centre, then SOC. The 

SEISCAN project used Seistrans to vectorise oceanographic geophysical profiles from six 

national oceanographic organisations. They worked in conjunction with Caldera Graphics SRL, 

based in Strasbourg, France, to develop cheap software that could vectorise paper records. The 

software was called Seistrans. In 2001 BGS acquired a copy of the software to run on a Solaris 

workstation. 

BGS holds a large number of paper records of seismic profiles (airgun, sparker and boomer) 

acquired from the 1960s onwards. There is a need to preserve these data as the paper medium 

deteriorates with age and also to reduce storage costs as paper records are bulky. To achieve 

these aims there is an ongoing programme of paper section scanning, the procedures for which 

have been described in IR/10/078. The procedures outlined in IR/10/078 have been designed to 

ensure that the scanned bit-maps are of sufficient quality to be vectorised using the Seistrans 

software. 

This report is a manual describing the process of converting bit-map images of paper seismic 

sections into SEG-Y files using Seistrans. In addition to the basic vectorisation of the seismic 

profiles, procedures using ProMAX (a seismic processing package) are described for:  

1)  Merging part lines into one final SEGY. Scanning long paper records with rotary scanners 

frequently results in distortions of fix and time lines. To reduce this phenomenon the 

lines are captured in many short sections, resulting in many output SEG-Ys that need to 

be merged. 

2)  Residual scanner drift results in a wavy, i.e. non-horizontal, time zero line. By picking the 

time zero line in ProMAX it is possible to apply a correction to the data such that the 

time zero line is horizontal. 

3)  The only navigation data available for the paper records will be tables of Fix number and 

Lat/Long coordinates. It is therefore necessary to generate FIX, trace tables so that the 

position of individual traces can be calculated from navigation files. 

4)  External recording delay corrections. It is common practice, in areas of rapidly varying 

bathymetry, to start the paper recording after a time delay so that the maximum paper 

area is used. This needs to be corrected for the digital file.  
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3 Vectorisation in Cameleo with Seistrans 

The Seistrans program is a module within a general graphics manipulation system called 

Cameleo developed by Caldera Graphics that runs on the virtual Solaris machine MHUJ. 

However, the scanned tiff images will exist on the SAN. The overall work-flow will be: 

1) Transfer TIFF graphics images from SAN to MHUJ using any ftp client tool, e.g. 

FileZilla 

2) Load one-byte (Black/White) tiff images into Cameleo 

3) Run Seistrans 

4) Generate output SEG-Y 

3.1 IMPORTING AND PREPARING BIT-MAP IMAGES IN CAMELEO 

Launch FileZilla and connect to MHUJ as user seistran. Then navigate to directory 

/users/seistran and transfer .tif images to be worked on into this directory. 

Connect to MHUJ using Hummingbird Exceed on a PC and launch an XTerm client logging in 

as user seistran. Type "cameleo &" without quotations in the XTerm as shown in figure 1. 

 

 

Figure 1 Starting Cameleo 

 

This will launch the Cameleo and CasImage windows shown in figure 2 below. 
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Figure 2 Cameleo windows 

Grab the Fileman icon and drag it out to open the Fileman window shown in figure 3. 

 

 

Figure 3 Fileman dialogue 

Use Fileman to load TIFF images into Cameleo. This will load to the 

/users/seistran/ImageWorkDir folder, and the display of this folder in CasImage will update to 

show the newly loaded image. File Manager can be closed by clicking on the Quit button. 
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Images that have just been loaded will be opened in the Vue window which is indicated in 

CasImage by a dog-eared icon. They will also be oriented vertically, this must be corrected first. 

Close this Vue window. 

Drag the image to be worked on from CasImage to the Geometry button in the Cameleo window. 

Geometry allows you to reorient an image, aligning it so the image is landscape, with the top of 

the data at the top of the image, reading left to right. The typical settings are shown in figure 4. 

Note that the image needs to be a simple B/W one byte TIFF image to work with Seistrans. 

 

Figure 4 Geometry Dialogue 

 



XX/00/00; Draft 0.1  Last modified: 2012/11/13 16:46 

 5 

3.2 DEFINING THE SEG-Y CONVERSION PARAMETERS IN SEISTRANS 

Drag the image from CasImage to Seistrans. The following window will be displayed. 

 

Figure 5 Seistrans Window, image selection tab 

 

Seistrans has six tabs and is designed to work from left to right. The leftmost tab is where the bit-

map image is selected. Seistrans interacts with the Vue image display. Origin, scale and trace 

information used in Seistrans is generated by user actions in the Vue image. 

Grab the image in CasImage and drag it out anywhere on the screen to open the Vue window. 

The Vue window starts with the Hand icon selected. Left click will zoom in, right click will 

zoom out and middle click will pan. The Hand can be found by clicking on the Screwdriver icon, 

and selecting it from the menu. Note that the Seistrans icon appears in the top left-hand corner. 

The screwdriver icon will reveal a submenu of Hand & Ruler. 

The Ruler tool, also found under the Screwdriver icon, will give pixel position information for 

the cursor, and will also show the angle of the Scale line defined later. 

The Zoom tool, the magnifying glass at the top of the Vue window, will zoom the view to a set 

scale. This zoom will be centred on the centre of the screen. 



XX/00/00; Draft 0.1  Last modified: 2012/11/13 16:46 

 6 

 

Figure 6 Vue window with tool icons 

 

Zoom in on the time 0 line on the first fix. Quite often, which horizontal line at the top of the 

record is time 0 will not be obvious. Zooming out to 1:4 and measuring by hand the distance 

between two other time lines, then applying that measurement above the first time line can 

highlight the time 0 horizon. 

Once you've identified the beginning of the data section zoom in to 1:1 on it, click on the genie 

lamp icon, and choose the axes icon (first one in list). 
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3.3 DEFINING AXIS & SCALE 

 

Figure 7 Seistrans Window, Axis & Scale tab 

 

The first click with the axes tool will place the origin point, and the Axis&Scale tab in Seistrans 

will reflect your actions. Place this on the intersection of the time zero line and to the left of the 

fix line as shown below. 

 

Figure 8 Defining the first point 

 

Once the origin is set, pan down the record to define the maximum time of useful data. 

Generally, there are no useful data to be captured below the first or second seabed multiple. 

Sparker records, for example, will show only echoes and noise below the third time line. Thus 

we don't need to capture the bottom part of the record.  
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Zooming out to 1:4 will allow more than one time line to be shown on screen, making 

identifying the third time line easier. The second click with the axes tool will place the time end 

point, so zoom in to 1:1 and place it at the third time line, to the left of the fix line.  

 

Figure 9 Example seismic showing time lines 
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Once the time end is set, zoom out for a better view, pan across to the end of the record section, 

and zoom in again at the top. The third click with the axes tool will place the trace end point. 

Place this at the intersection of the time 0 line and to the right of the final fix line. 

This should be done approximately every 5 fixes, to reduce the impact of record drift. 

 

Figure 10 Defining the third point 

 

Seistrans will automatically use these three points to create a parallelogram defining the data. 

Zoom out so that you can see the top and bottom of the record at the same time without needing 

to pan up or down. Zooming out to 1:8, then right clicking with the pan hand usually suffices. 

Click on the genie lamp icon, and click on the second tool in the menu, the hourglass icon. 

Click once on the red line at the top of the record, and drag down in a straight line to the bottom 

of the record, clicking on the red line again. This will provide the Scale (pix) value on the 

Axis&Scale tab in Seistrans. Use the ruler to ensure the scale line is straight. 

The Scale (ms) value should be filled in from the header information on the record. For Sparker 

data, this is usually truncated to 300 ms, due to echoes and noise. 

The sample rate is typically 0.05 for boomer data, 0.5 ms for Sparker records, and 1 ms for 

airgun records. Note that external delays are not uncommon, so that the origin of the record may 

not be zero time. However, it may be convenient to keep it zero and note the time delay for later 

processing in ProMAX. 

Traces should then be generated. Click on the Traces tab in Seistrans, set Method to Manual and 

then set Display to Nothing or Some Traces. Long waiting times are incurred by displaying all 

traces. 

Trace width is calculated from the time per fix and the firing rate. If 600 seconds elapse between 

2 fixes (obtained from navigation data), and the firing rate is 1s (found on record header), then 

there should be 600 traces per fix. On 600 dpi images, this equates to approximately 2400 pixels 

per fix, thus trace width should be 4 pixels per trace. 

Trace width for Sparker records is typically 4. For airgun with 6 s firing rate this increases to 24. 

Note that the Seistrans software is designed to vectorise wiggle trace data not variable area. So 

the amplitudes calculated from variable area records will be totally meaningless and will simply 

present a picture of ‘tramlines’ in seismic interpretation workstations, whereas with wiggle-trace 

displays it will attempt to recreate a real waveform. 
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3.4 DEFINING PARASITES 

 

Seistrans can optionally ignore time and fix lines when generating the SEG-Y file. It describes 

these marks as parasites. However, retaining these lines within the SEG-Y file is in fact very 

useful when dealing with BGS paper records. Firstly, because these profiles are always variable 

area records we can never hope to properly reconstruct the true amplitude waveform. Secondly, 

scanning introduces artefacts in the form of wavy time-lines and non-vertical fix lines which the 

interpreter needs to be aware of. Retaining the parasites in the SEG-Y is a useful measure of data 

quality.  

3.5 DEFINING TRACES 

 

Figure 11 Seistrans Window, Traces tab 

 

Populate the Header information. Headers must contain 40 lines, or errors will ensue. Click on 

the Header tab. Template_Header.dat should be loaded, but if not, click load to import a template 

Header. Template_Header should have C01 - C40 running down the left side. This automatically 

fills the requisite number of lines. 

Enter line information as necessary, including line name, equipment type, direction of fix 

progression, Sample step (rate) and Scale (sweep/time length in ms) from Axis&Scale tab, and 

Number of Traces from Traces tab. 
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3.6 DEFINING HEADER 

 

Figure 12 Seistrans Window, Header tab 

 

Generate the output. Click on the Output tab in Seistrans. Action should be Write SEG-Y file. 

Algorithm should be Default (compute patch coverage). Filename should be the name of the file 

and/or file section, in the directory /users/seistran/segy/... 

You may need to click twice on the small red button beside Auto in time range and trace range, 

to update the N fields for these. 

Once done, click Apply. If you haven't set time lines, you will get a popup message stating thus, 

click ok. The SEG-Y will then generate. 

If you are generating further SEG-Y files from the same image, you must click Quit on Seistrans 

before repeating the process; otherwise Seistrans will crash as soon as you click Apply to 

generate the second or further file. 
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3.7 DEFINING OUTPUT PARAMETERS 

 

Figure 13 Seistrans Window, Output tab 

Here we ensure that the output time and trace ranges are sensible and click on apply. 
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4 ProMAX Processing 

The output from Cameleo’s Seistrans will consist of a number of SEG-Y files covering patches 

of a full line. This is due to the need to minimise scanner drift and other distortions. Within 

ProMAX we will: 

 Read in these individual parts of lines 

 Standardise trace lengths to accommodate application of external time delays 

 Apply corrections for any external time delays 

 Merge all part lines into a single SEG-Y file 

 Digitise the time zero line and use the horizon to flatten the seismic (i.e. compensate for 

residual scanner drift) 

 Export a table of fix-trace values for loading into SeisWorks, Kingdom or equivalent 

seismic interpretation packages as usually only the fix values have navigation data, so 

positioning the traces is done by linear interpolation between fix points. 

The processing sequence required is identical for all equipment types. The examples listed are 

based on Sparker data, but apply equally to the other data types. 

4.1 PROMAX INTRODUCTION 

ProMAX is a suite of professional geophysical processing tools, and is used in this workflow to 

manipulate the SEG-Y generated by Cameleo. 

Launch XTerm and log in as Seistrans. Type go_seis to launch ProMAX. 

 

Figure 14 Starting ProMAX from an XTerm window 

Currently set up in ProMAX are two areas; the Template area contains template flows used to 

copy to a new line’s processing work, held in the Sparker area. Left clicking on the name of an 

area will open it. Further areas will be set up for other equipment types. 
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Figure 15 ProMAX window 

 

Within the Sparker area each line has its own individual substructure. To create a new line, 

click Copy, select Template from the dialogue that pops up, and then select the type of line you 

wish to create a template of, in this case Sparker. A highlight will then show that you are to type 

in the name of the new line, do so following the style of the other lines present. 

 Left clicking on a line name will open it.  

 

Figure 16 ProMAX Line selection window 

 

Each line has a series of processing flows, datasets and tables. Left clicking on a flow will open 

it for editing or executing. Left clicking on datasets will open the list of ProMAX datasets 

associated with this line. Be warned that moving the mouse pointer outside the datasets window 

will close it and display the flows window again. 

Each flow has a series of processing functions selected from the list on the right. 

These flows should already have the correct functions included.  

Some functions included in a flow may not be needed for a particular record type. These 

functions can be enabled or disabled by right clicking on them. Functions that are not active will 

appear greyed out and flanked by >< symbols. 

Middle clicking on any function in the flow will display its parameters. 

Flows are executed from top to bottom. 
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Figure 17 ProMAX flow selection window 

4.1.1 The 01Load Flow 

The first processing flow that must be used is the 01Load flow, which will import SEG-Y data 

into ProMAX. Left click on this flow to open it for editing. 

 

Figure 18 ProMAX process selection window 

 

Middle click on SEG-Y Input to edit the following; 

Left click on the path shown in the field to the right of Enter DISK file path name to point to 

the SEG-Y to be loaded. This text editor is EMACS-based, the arrow keys on the keyboard will 

move the cursor, and delete will always erase the character before the cursor. Moving the mouse 

pointer outside the black boundary will exit the text editor, so beware doing this before you have 
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finished editing the full pathname. Currently all SEG-Y files should be held in the directory 

already entered - you should only need to enter the filename. 

The Correct sample interval field should be 0.5 - the same value applied during SEG-Y 

creation. 

Trace DC Removal removes the DC bias that CODA applies to SEG-Y it generates, ensure this 

function is active. The values already set should not be changed. 

 

Figure 19 ProMAX SEG-Y parameterisation dialogue 

 

Trace Length and Header Statics correct for external delays. If the SEG-Y being worked on 

has no external delays, leave these two functions greyed out. If the record has an external delay, 

see Section 4.4. 

 

Trace Equalisation scales all traces to ensure no erroneously large values get through, which 

might cause abnormal file sizes and/or corruption. The values already set should not be changed. 

 

Figure 20 ProMAX trace equalisation parameterisation dialogue 

 

Trace Display is useful as a quality control checkpoint, in that it will display what you are 

loading, allowing you to assess if the load is going correctly. The values already set should not 

be changed. 
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Each part SEG-Y file should be output to a ProMAX file at 16bit. Middle click on Disk Data 

Output. Left clicking on the Output Dataset Filename field (shown in the screenshot as 

INVALID) will allow you to edit the target dataset. 

 

Figure 21 Disk data output parameterisation 

 

This will take you to the Datasets window. If there are no datasets currently existing for a line, a 

text entry field will already be highlighted. If datasets already exist or you move the mouse 

before entering a dataset name, left click Add at the top, then type the name of the new dataset to 

be created using the format F[fix range start]-[fix range end], e.g. F01-05. Left click on the 

name of the new dataset to be returned to the Flow window. 

Beware that moving the mouse when editing text will cause the text entry to finish, and moving 

the mouse outside the Datasets window will cause it to close. 

 

Figure 22 ProMAX dataset selection 

 

Once all values are populated, click Execute at the top of the window to begin the flow. If Trace 

Display is active, the flow will pause upon reaching this, and allow you to preview the result. 

See section 6.4 for further information on the Trace Display window.  

Under the File menu in Trace Display one can choose to exit Trace Display and continue to the 

Disk Data Output, or, if the display was not correct, exit Trace Display and stop the flow. 
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4.1.2 The 02Merge Flow 

Once you have all loaded all the part files into ProMAX datasets, use the 02Merge flow.  

This flow is used to merge the part datasets into a single dataset. The flow will be executed 

twice. For the first execution the output will be to screen only (fig 23). During screen display we 

have the option of generating picks and tables for generating fix-trace tables.  

The first entry, Disk Data Input, should be the first part dataset, and each subsequent one should 

be inserted after it. Ensure this is done in order. 

More Disk Data Insert functions may need to be activated, or added to the flow. The function’s 

location is also shown below. 

Middle click on Disk Data Input or Disk Data Insert and left click on the Select Dataset field 

name to open the datasets window, left click on the dataset to select it. 

 

Figure 23 ProMAX - 02 Merge flow 

Ensemble Redefine is necessary to re-sequence all FFID values to increase monotonically. 

Maximum traces should be set to 99999. This value acts as an infinite value. Values lower than 

this may cap long lines. There is an operational limit of 500000 in place. (fig. 24) 
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Figure 24 ProMAX - 02 Merge flow parameterisation 

 

Trace Header Math will populate the SEG-Y header with the required linearly incrementing 

CDP numbers for later processing. The values already set (fig. 25) and should not be changed. 

 

Figure 25 ProMAX - 02 Merge flow trace header math 

 

Once each Data Insert is populated as required, one can set up the output. Middle click on Disk 

Data Output, and left click on the Output Dataset Filename field. Add a new dataset using the 

format ALL_LineXX substituting XX for the line number.  

This needs to be a 16-bit output. At this point the trace display is toggled off (fig. 26) and the 

flow is executed again. 
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Figure 26 ProMAX - 02 Merge flow selecting output destination 
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4.1.3 ProMAX Trace Display 

Trace Display will allow you to preview the final output and also do other things such as pick 

horizons for subsequent processing flows and generate data tables. The Trace Display generated 

in the 02Merge flow is used to create a trace to fix-trace table. This is essential for spatially 

locating the line. Essentially, the fix numbers are the points where navigational information is 

available during the cruise. So, to correctly position individual traces, a table of fixes and their 

associated trace number must be generated for each line. 

 

 

Figure 27 ProMAX trace display 

 

Left clicking on View -> Colourmap will allow you to edit the display to show sparker-ideal 

colours. Click File -> Open, and then edit the Filter field to read /users/seistran/*.rgb. Click the 

Filter button at the bottom of the dialogue, and then select sparker.rgb at the right. Click OK. 

This will change the display to black and white, mimicking the original record. Click File -> 

Close to exit the Colour Editor. 
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Figure 28 ProMAX changing colour ramp on display 

 

 

Figure 29 ProMAX display using the sparker colour ramp. The data now resemble the 

paper record. 
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Left clicking on the arrow at the top left will allow you to proceed through the display. The 

arrow pointing the other way that should send the view back towards the beginning doesn’t 

work, possibly because the display is a preview generated on the fly. 

To aid the independent loading of these data into the Landmark system, a table of trace number 

to shotpoint is required. Left click Picking, then Pick Other Horizons. Create a new table called 

trace by entering trace into the Enter a new table name field, then clicking OK. 

 

 

Figure 30 ProMAX display, create a trace table and digitise the fix points to generate fix-

trace table. 

 

To create the table, a node needs to be place at each fix, which serve as shotpoints. The node will 

then have its X coordinate logged in the table, which equals its CDP/Trace Number. Proceed 

through the display clicking near the top of a fix line placing nodes at each fix line. Vertical 

accuracy is not important, but horizontal is. Occasionally at merge seams there may be two lines 

for each fix - use the most vertical for placing the point. 
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Figure 31 ProMAX display of merged file illustrating FIX uncertainty due to scanning 

artefacts 
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4.1.4 The 03Export Flow 

Run flow 03 Export.  

This takes the ALL_LineXX dataset you just created and exports it to a SEG-Y file. 

 

Figure 32 ProMAX - 03 Export flow parameterisation 

 

Middle click on Disk Data Input, then left click on the Select Dataset field, and left click on the 

ALL_LineXX dataset made previously. 

Middle click on SEG-Y Output and then left click on the Disk File Path Name field. 

SEG-Y outputs are currently being stored in the /data/DK21/ directory. 

They are being stored under the format; 

 bgs[year]-[project][equipment type]-[line number].sgy 

With equipment type being a single character, e.g. ‘s’ for sparker data, ‘b’ for boomer data, and 

‘a’ for airgun data. 

 

 

Figure 33 ProMAX - 03 export SEG-Y file specification 
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4.2 EXPORTING A FIX-TRACE FILE FOR USE IN SEISWORKS 

Navigate to the Flows window of the line just output. Left click Tables, and then select Horizon 

Picks. This will display all horizon pick tables for the line. The table created earlier should be 

listed here. Left click Edit and select the table Trace that was created in flow 02. 

 

Figure 34 Selecting Horizon Pick tables 

 

Left click Format, and it should automatically navigate to the required location, so select the 

available format to show the data. 

 

Figure 35 Ascii File Export 

 

Click File -> Export to export the table to a file. 
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Figure 36 Parameter Table example 

 

This will export the two columns CDP and Z to a file. 

Click OK on the Apply Export window to export the file. This file should be a .dat using the 

same format as the output SEG-Y. This should be saved to the /users/seistran/ directory. 
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Figure 37 Example export definition 

 

 

Figure 38 Apply export dialog 

 

On the Parameter Table – trace window, click File -> Abort to exit, and on the ASCII File 

Export window, click Cancel. 

4.3 HORIZON TABLE EDITING WITH EXCEL 

Transfer the .dat to SAN or PC local drive using FileZilla.  
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Figure 39 Opening FixTrace.dat file in Excel 

 

Launch Excel and use the Open dialogue to open the .dat file. The file should be opened as 

‘Delimited’, and then ‘Space-delimited’. 
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Figure 40 Example Fix-Trace file in Excel 

 

Rearrange the columns, insert the filename column and populate, resequence the Z column to 

show Shot Point numbers. The total Shot Points should equal the number of fixes you picked. 

Save this file as a .prn to preserve formatting (fig. 41), this is the final table that can be used in 

SeisWorks or another seismic interpretation package to physically locate the line spatially in 

conjunction with a cruise navigation file that contains Fix, X & Y positions. 
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Figure 41 Final Line, trace, fix ready for export 
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4.4 HANDLING EXTERNAL TIME DELAYS 

4.4.1 What is an External Time Delay? 

Until 1992 BGS surveys were acquired on paper records only, no digital recording was 

performed. Thus it was desirable to display the data utilizing the maximum area of the paper by 

using a narrow time window, e.g. 1 s on an airgun record. In areas of strong bathymetric 

variations the seabed event can appear later than this time. To ensure sub seabed data were 

captured it was common practice to periodically change the print delay by e.g. 100 ms. Thus the 

first time line is no longer 0 ms but 100 ms. This obviously introduces step changes on the 

physical record. 

The use of a swell filter can also induce an external delay. Below is an example of a swell filter 

delay on the paper image. 

 

Figure 42 Example of change of external delay on digital record 

 

For a digital record the external delays need to be removed so that all the data use the same 

recording datum. In areas of intense bathymetric variations this can be lengthy process. The 

image below shows the same section of record, but after the delay has been corrected. 
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Figure 43 External delay corrected. Note the effect of scanning drift in producing the 

double Fix line 

 

4.4.2 Identifying External Delay parameters in SeiSee 

The first step in correcting a delay is identifying whether the delay is Positive or Negative. A 

Negative delay is where the delayed traces appear to move vertically down when compared to 

the rest of the data. These can occur when a swell filter is activated, or when the bathymetry 

shallows. A Positive delay can occur when the bathymetry deepens beyond the end sweep time. 

The second step is identifying what trace range is affected, and by how long a delay. Using 

SeiSee, zoom in on the start of the external delay. This screenshot shows a Negative delay. 
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Figure 44 External delay on SeiSee display 

 

Next, click on the record at the point of the delay. This will highlight the trace clicked on with a 

blue line. You may need to click further to the left or to the right to ensure you are selecting the 

right trace. The right trace is the one where the blue line is straight on the white parts of the non-

delayed record, but shows peaks where there are black areas. See the screenshot below for an 

example. Displayed at the upper left in the Info box is the trace selected, in the example below 

this is Trc#975. Make a note of this trace number, as it will be used to define when to start the 

delay correction. 
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Figure 45 External delay in SeiSee display. Seismic summary 

 

Identify a reflector that you can easily find on both sides of the delay. The seabed line is usually 

the best for this, as it will be the top line. Occasionally the Time 0 line is better for this purpose.  

Once a suitable reflector has been identified, hover the mouse pointer over the top of it and look 

at the bottom middle of the SeiSee window. There is a time box that displays the time in 

milliseconds down the record that the mouse pointer is at. Make a note of this value. 

Move the mouse pointer to hover over the same reflector on the other side of the delay. Look 

again at the time display, and make a note of this value also. 

Subtracting the second value from the first will give you the total time adjustment of the delay. 

In the example above, the result of this will be a negative number; this is because the delay is a 

Negative one. 

The final step in SeiSee is to identify the end of the delay. The process is very similar to 

identifying the starting trace, except that this time the blue line should not show any peaks that 

can be associated with reflectors in the non-delayed section. Make a note of this trace by looking 

in the Info box at the top left. In this example the end trace is Trc#4730. In some cases the delay 

can extend beyond the end of a SEG-Y section. In these cases the Summary information on the 

left will show the total number of traces in the file, # Traces : XXXX, the number printed here 

will be the final trace in the file, which will equal the end of the delay. If the delay continues on 

the next record that delay is treated completely independently. 
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Figure 46 Identifying correct trace for the change in external delay 

 

The values identified and noted in SeiSee can now be used in ProMAX to correct the delay. 

4.4.3 Correcting External Delays in ProMAX 

Held within the 01Load flow are the two functions, Trace Length and Header Statics, needed 

to correct a delay. Ordinarily these processes are greyed out, as their functions are not necessary 

for non-delayed data. 

Trace Length adjusts the total time of the trace, and is used when handling Positive external 

delays. Trace Length can be left inactive if handling a Negative external delay. 

If time length = 300 ms but a 50 ms Positive external delay is applied, then Trace Length must 

be increased to 350 ms, or the bottom 50 ms of data will be cut off. The field is a simple numeric 

value. 
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Figure 47 Changing trace length to accommodate changing of external delay 

 

Header Statics will Add or Subtract X amount of blank time to the data, specified via the Bulk 

shift static field. Using Add with a positive value will add the specified value to the top of the 

data, using Subtract with a negative value will remove the specified value from the top of the 

data. The methodology specified above should automatically furnish you with the correct value, 

positive or negative. 

 

Figure 48 Applying header statics to correct for external delay. 

 

If for example you have a SEG-Y section that contains non-delayed data and delayed data, then 

you have two datasets to make from the same SEG-Y Input. To specify what range of traces 

need to be corrected; we edit the parameters of SEG-Y Input. 

4.4.3.1 LOADING NON-DELAYED DATA SECTIONS 

Set the Input PRIMARY selection choice field under SEG-Y Input to Trc. Seq. No., and input 

the trace range. From the template this field should be set to Input All, click on this to change it. 

Setting this field to Trc. Seq. No. will display another field below it displaying usually 1-100/. 

Click on this to edit the field to read the trace range of the first dataset section. Taking the 

example above the field value would be 1-975/. This section does not need any delay correction, 

so Trace Length and Header Statics are left inactive. In Disk Date Output a dataset suffixed 

with “_1” should be made for this section. Execute the flow to create the first section. 

4.4.3.2 LOADING DELAYED DATA SECTIONS 

The second section does require delay correction. The trace range under SEG-Y Input should be 

set to the second section, in the example this would be 975-4730/. Trace Length and Header 

Statics should be active if the delay is Positive, or if as in the example the delay is Negative only 

Header Statics should be active. Populate the Bulk shift static field with the time value of the 
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delay, remembering to ensure the value polarity matches that of the delay; i.e. negative if the 

delay is Negative. Set HOW to apply header statics to Add if the delay is Positive, or Subtract 

if the delay is Negative by clicking on the field. In Disk Date Output a dataset suffixed with 

“_2” should be made for this section. Execute the flow to create the second section. 

Continue until the entire section has been loaded into as many dataset parts as necessary. These 

dataset parts are treated in exactly the same way as datasets that have no delays. 

 

Appendix 1 Using SeiSee 

Sparker SEG-Y output using the technique above require header correction. This is because 

Seistrans does not correctly write non-integer values, and so whilst Sample Step (ms) is defined 

as 0.5, it is written as 0 in the output file. To correct this, SeiSee is used. 

Launch FileZilla and connect to MHUJ using seistran logon. 

Navigate to directory /users/seistran/segy. 

Transfer .segy files output to a location on the SAN. [specify location] 

Launch SeiSee, and open the SEG-Y to be corrected. 

SeiSee will open this file in Recovery mode, as seen in the image below. This mode allows the 

binary or text headers to be corrected. 
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To correct the bin header issue, click on the Bin header radio button in SeiSee.  

Place a check in the Allow to edit all items box. This highlights three rows. The top row will 

read 0 for sample interval in microseconds. This value needs to be edited to read 500. 

As soon as you edit a value, the Reset and Update buttons appear. Click Update to finalise the 

edit to the header. 

SeiSee will need to be restarted now to display the record.  

 

 

SeiSee can now display the record, allowing you if necessary to calculate the trace numbers and 

time variance of any external delays present. 

This record is now ready to be processed in ProMAX. 
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